
Converting QuickBooks for Mac to AccountEdge

Introduction

The steps detailed within this document will allow you to convert your company files from 
QuickBooks Pro for Mac to AccountEdge.  These steps will work with most versions of 
QuickBooks and all versions of AccountEdge.  

Our goal is to save you as much time as possible while you transition your business 
management system.  Not all transactions, processes, reports, and screens are identical in 
AccountEdge and QuickBooks.  While “accounting is accounting’, AccountEdge takes a very 
different approach to helping you manage your business by making accounting accessible to 
you.  But don’t worry; you won’t need a degree in accounting to get up to speed quickly.  

Note: These instructions will help you convert master records only: Accounts, Cards, 
Items.  Previous transaction history is not addressed in this document.  

Visit our switch page for more options and help on what to do with old transaction data, 
files, and reports.  Be sure to request a Free Accountant Copy for your CPA.  AccountEdge 
files are cross platform, so an AccountEdge Mac file can be opened natively on a Windows 
computer with AccountEdge for Windows (formerly known as Premier Accounting).

Before you begin

Please follow all instructions, including reading up on help files referenced within this 
document. If you are reading this as a PDF, clicking each help document title will bring you to 

AccountEdge’s online help; additionally, the breadcrumb trails have been included so that 
you can find the specified help files from the help table of contents.

Take a few minutes to read through the following help documents in order to familiarize 
yourself with AccountEdge. Reading these documents first will help you to successfully 
convert your files further along in the process.

• Create a Company File Setting up your company file > Create a company file

• Set Up Preferences Setting up your company file > Set up preferences

• Accounts Setup Setting up your company file > Set up accounts 

• All Import Fields Importing and exporting data > Importing data

• Import and Export fields Importing and exporting data > Importing data > Related 
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topics > Import and export fields

• File Formats for Importing Importing and exporting data > Managing import and 
export records

Importing Records

How to import your QuickBooks fields into AccountEdge

A basic knowledge of Microsoft Excel functions will help you to complete some of the steps of 
this document. The key to bringing your data from QuickBooks into AccountEdge  is being 
comfortable working with that data in Excel, understanding the additional fields available in 
AccountEdge, and using Excel to maximize the data you convert.

It is also assumed that you have some knowledge of the menus and reports found in 
QuickBooks.

Here is a quick trick: Open AccountEdge and select the Sample Company, Widgets & Co.  From 
Widgets, EXPORT (File>Export Data>Accounts>Account Information, Cards>Customer Cards, 
Vendor Cards, Items) all the data you will eventually IMPORT.  Open those files in Excel.  Now 
you’ll see immediately the look and feel of the files you will be creating, by exporting the 
available data from QuickBooks, using Excel to modify it, and then saving as txt files for 
importing into AccountEdge.  

Take time to closely study the Excel files you eventually create, we suggest you delete any 
data you won’t need moving forward (accounts you don’t use, old customers and vendors, 
items you don’t sell).  

Other notes on importing:

• Below you will find a list of all the QuickBooks fields you can import in to AccountEdge. 
The table shows the name of the AccountEdge field on the left, the name of the 
corresponding QuickBooks field on the right. 

• For example, the first field listed shows ‘Account Number’ on the left (the 

AccountEdge field name) and ‘Accnt. #’ on the right (it’s QuickBooks counterpart). 
Beneath those two field names you will find a brief description of the attributes of a 
given AccountEdge field.

• Please note there is not a corresponding QuickBooks field for each available 

AccountEdge field. We’ve included these fields so that you know they are available to 
you.
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• Before importing information into AccountEdge, please confirm that all fields are in 
the correct format and meet the criteria detailed in this section of the guide.

• When importing your file into a spreadsheet, it is important to note that the top cell in 
a given column is recognized by AccountEdge as the header. If a character is entered in 
this field AccountEdge recognizes that character as a header account. If this field is 
blank, AccountEdge recognizes it as a detail account.

• AccountEdge fields marked with an asterisk* must be filled in for successful import.

• Conditional Fields^: fields marked with a caret^ are conditional fields. When 
importing, one or both fields must contain valid entries for matching fields in the 
company file.

• Work with Excel  to  add in as much detail as you want before importing.  There are lots 
of data fields in AccountEdge that QuickBooks doesn’t have, so use Excel to fill in as 
much detail as possible.  

• Become familiar with the Import Log, located in the same folder as your AccountEdge 
application.  This log will give you details of each import, including how many records 
imported, how many didn’t and why.  

• Finally, feel free to experiment, but make copies of your AccountEdge files before each 
step.   Records can be updated after  you import them the first time, as long as the 
required or conditional fields match.  
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Field Comparison: AccountEdge = QuickBooksField Comparison: AccountEdge = QuickBooks

AccountsAccounts
* Required Field.  Must have a valid matching import field.  * Required Field.  Must have a valid matching import field.  

* Account # Accnt. #

In AccountEdge, account numbers are displayed with five characters, all numeric. An AccountEdge account 
number may have an optional non-numeric separator between the first digit and the last 4 digits as shown 
below:

• 1-XXXX = Asset 
• 2-XXXX = Liability 
• 3-XXXX = Equity
• 4-XXXX = Income 
• 5-XXXX = Cost Of Goods 
• 6-XXXX= Expense 
• 8-XXXX= Other Income 
• 9-XXXX = Other Expense

In AccountEdge, account numbers are displayed with five characters, all numeric. An AccountEdge account 
number may have an optional non-numeric separator between the first digit and the last 4 digits as shown 
below:

• 1-XXXX = Asset 
• 2-XXXX = Liability 
• 3-XXXX = Equity
• 4-XXXX = Income 
• 5-XXXX = Cost Of Goods 
• 6-XXXX= Expense 
• 8-XXXX= Other Income 
• 9-XXXX = Other Expense

Account Name Account

Account names in AccountEdge can be named with a maximum of 30 alphanumeric characters.Account names in AccountEdge can be named with a maximum of 30 alphanumeric characters.

Header N/A

Header accounts are used as titles of groups of accountsHeader accounts are used as titles of groups of accounts

Balance Balance Total

You can enter up to 13 characters (including numbers, currency signs, commas, negative signs). If no decimal is 
entered, AccountEdge appends .00; if more than 2 decimal places, AccountEdge rounds to 2 decimals.

When importing, AccountEdge enters the balance in the opening balance field of each account.

You can enter up to 13 characters (including numbers, currency signs, commas, negative signs). If no decimal is 
entered, AccountEdge appends .00; if more than 2 decimal places, AccountEdge rounds to 2 decimals.

When importing, AccountEdge enters the balance in the opening balance field of each account.

Account Type Type

25 characters, alphanumeric.25 characters, alphanumeric.

Last Check Number N/A

7 characters, alphanumeric.7 characters, alphanumeric.

Currency Code N/A

3 characters, alpha. When importing, must match a pre-existing currency code in the Currency List. If a foreign 
currency account, must have an exchange account specified.
3 characters, alpha. When importing, must match a pre-existing currency code in the Currency List. If a foreign 
currency account, must have an exchange account specified.

Exchange Account N/A

Used when multiple currencies are being tracked.Used when multiple currencies are being tracked.

Inactive Account Active
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Denotes if this account is active or inactive.  Denotes if this account is active or inactive.  

ABA Routing N/A

Enter the routing number assigned to your company’s bank by the American Bank Association.Enter the routing number assigned to your company’s bank by the American Bank Association.

B/Account Number Bank No. / Note

Your company’s bank account number.Your company’s bank account number.

B/Account Name N/A

The name of your company’s bank accountThe name of your company’s bank account

Company Trading Name N/A

The name by which your company does business.The name by which your company does business.

Description Description

Max 255 characters, alphanumeric.Max 255 characters, alphanumeric.

Classification for Statement of Cash Flow N/A

1 character from the following list: 
O - Operating 
I - Investing 
F – Financing
E - Exclude from Statement for Cash Flow

These classifications work for all account types except Bank, Income, Expense, Cost of Sales and Header 
accounts.

1 character from the following list: 
O - Operating 
I - Investing 
F – Financing
E - Exclude from Statement for Cash Flow

These classifications work for all account types except Bank, Income, Expense, Cost of Sales and Header 
accounts.

Subtotal header Accounts N/A

1 character, alphabetical: 
Y - yes 
N - no
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Field Comparison: AccountEdge = QuickBooksField Comparison: AccountEdge = QuickBooks

Customer CardsCustomer Cards
This process is virtually identical for vendors and other Card types.  
For details on import and export fields, go here.

^ Conditional Field. When importing, one or more fields must contain valid entries for matching fields in the 
company file.

This process is virtually identical for vendors and other Card types.  
For details on import and export fields, go here.

^ Conditional Field. When importing, one or more fields must contain valid entries for matching fields in the 
company file.

^ Co./Last Name Company

If a company name (no first name), 50 characters, alphanumeric. If a last name, 30 characters, alphanumeric.If a company name (no first name), 50 characters, alphanumeric. If a last name, 30 characters, alphanumeric.

First Name N/A

20 characters, alphanumeric.20 characters, alphanumeric.

^ Card ID N/A

15 characters, alphanumeric. Must be a unique ID. If you try to import an ID that already exists, the ID "*None" 
will be assigned.
15 characters, alphanumeric. Must be a unique ID. If you try to import an ID that already exists, the ID "*None" 
will be assigned.

Card Status Active

To denote active or inactive statusTo denote active or inactive status

Currency Code N/A

3 characters, alpha. When importing, must match a preexisting currency code in the Currency List. If no code 
specified, local currency substituted.
3 characters, alpha. When importing, must match a preexisting currency code in the Currency List. If no code 
specified, local currency substituted.

Address (Address broken down by type, below)

1 (2-3-4-5) (Customers and vendors can have up to 5 addresses each in AccountEdge, therefore you can match 
your Ship to and Bill to Address to any of the 5 available in AccountEdge).

Total Address field (lines 1 through 4) cannot exceed 255 characters, alphanumeric.

1 (2-3-4-5) (Customers and vendors can have up to 5 addresses each in AccountEdge, therefore you can match 
your Ship to and Bill to Address to any of the 5 available in AccountEdge).

Total Address field (lines 1 through 4) cannot exceed 255 characters, alphanumeric.

Line 1 = Street1 
Line 2 = Street2 
Line 3 = N/A 
Line 4 = N/A 
City = City 
State = State

Can not exceed 255 characters, alphanumeric (each field).

Line 1 = Street1 
Line 2 = Street2 
Line 3 = N/A 
Line 4 = N/A 
City = City 
State = State

Can not exceed 255 characters, alphanumeric (each field).

ZIP Code Zip

10 characters, alphanumeric.10 characters, alphanumeric.

Country Country

255 characters, alphanumeric.255 characters, alphanumeric.

copyright © 2010 Acclivity, LLC.

http://help.acclivitysoftware.com/us/ae10/mac/impexptables.36.1.htm#4818184
http://help.acclivitysoftware.com/us/ae10/mac/impexptables.36.1.htm#4818184


Phone #1= Phone
Phone #2 = Alt.Phone
Phone #3 = N/A

21 characters, alphanumeric (each field).

Phone #1= Phone
Phone #2 = Alt.Phone
Phone #3 = N/A

21 characters, alphanumeric (each field).

Fax # = Fax 
Email = Email 
WWW = N/A

21 characters, alphanumeric (each field).

Fax # = Fax 
Email = Email 
WWW = N/A

21 characters, alphanumeric (each field).

Contact Name Contact

25 characters, alphanumeric.25 characters, alphanumeric.

Salutation Prefix

15 characters, alphanumeric.15 characters, alphanumeric.

Picture N/A

File name of the graphic. 255 characters, alphanumeric.File name of the graphic. 255 characters, alphanumeric.

Notes Note

255 characters, alphanumeric.255 characters, alphanumeric.

Identifiers N/A

10 characters, alpha only.10 characters, alpha only.

Custom List 1 = N/A 
Custom List 2 = N/A 
Custom List 3 = N/A

30 characters, alphanumeric (each field).

Custom List 1 = N/A 
Custom List 2 = N/A 
Custom List 3 = N/A

30 characters, alphanumeric (each field).

Custom Field 1
Custom Field 2 
Custom Field 3

Define Fields

30 characters, alphanumeric (each field).30 characters, alphanumeric (each field).

Billing Rate N/A

10 characters, numeric including 4 decimal places10 characters, numeric including 4 decimal places

Terms – Payment is Due Terms
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1 character, numeric. Use one of these codes to indicate when payment is due: 
0 - COD 
1 - Prepaid 
2 - In a Given # of Days
3 - On a Day of the Month 
4 - # of days after EOM 
5 - Day of Month after EOM

1 character, numeric. Use one of these codes to indicate when payment is due: 
0 - COD 
1 - Prepaid 
2 - In a Given # of Days
3 - On a Day of the Month 
4 - # of days after EOM 
5 - Day of Month after EOM

Terms – Discount Days N/A

1 character, numeric. Use one of these codes to indicate when payment is due: 
3 characters, numeric, based on Payment is Due code:

If code 0, 1, 2 or 4 indicates when payment is due, use a number of days from 0‑999.

If code 3 or 5 indicates when payment is due, use a date from 1‑31. (EOM=31)

1 character, numeric. Use one of these codes to indicate when payment is due: 
3 characters, numeric, based on Payment is Due code:

If code 0, 1, 2 or 4 indicates when payment is due, use a number of days from 0‑999.

If code 3 or 5 indicates when payment is due, use a date from 1‑31. (EOM=31)

Terms – Balance Due Days N/A

3 characters, numeric, based on Payment is Due code:

If code 0, 1, 2 or 4 indicates when payment is due, use a number of days from 0‑999.

If code 3 or 5 indicates when payment is due, use a date from 1‑31. (EOM=31)

3 characters, numeric, based on Payment is Due code:

If code 0, 1, 2 or 4 indicates when payment is due, use a number of days from 0‑999.

If code 3 or 5 indicates when payment is due, use a date from 1‑31. (EOM=31)

Terms – % Discount N/A

2 numeric characters to the left of a decimal point and 2 numeric characters to the right of the decimal point 
(example: 00.10).
2 numeric characters to the left of a decimal point and 2 numeric characters to the right of the decimal point 
(example: 00.10).

Terms – % Monthly Charge N/A

2 numeric characters to the left of a decimal point and 2 numeric characters to the right of a decimal point 
(example: 00.10).
2 numeric characters to the left of a decimal point and 2 numeric characters to the right of a decimal point 
(example: 00.10).

Tax Code Taxable

3 characters, alphanumeric. When importing, must match a preexisting tax code in the Tax Code List.3 characters, alphanumeric. When importing, must match a preexisting tax code in the Tax Code List.

Credit Limit Credit Limit

7 characters, numeric before a decimal point and 2 characters, numeric after a decimal point.7 characters, numeric before a decimal point and 2 characters, numeric after a decimal point.

Tax ID No. Resale Number

19 characters, alphanumeric.19 characters, alphanumeric.

Volume Discount% N/A

2 characters, numeric before a decimal point and 2 characters, numeric after a decimal point.2 characters, numeric before a decimal point and 2 characters, numeric after a decimal point.

Sales/Purchase Layout N/A

copyright © 2010 Acclivity, LLC.



S - Service
I - Item
P - Professional
M - Miscellaneous invoice or purchase order layout 
T - Time Billing invoice layout.

S - Service
I - Item
P - Professional
M - Miscellaneous invoice or purchase order layout 
T - Time Billing invoice layout.

Price Level N/A

1 character, numeric:
0 - Base Selling Price
1 - Price Level A
2 - Price Level B
3 - Price Level
4 - Price Level D
5 - Price Level E
6 - Price Level F

1 character, numeric:
0 - Base Selling Price
1 - Price Level A
2 - Price Level B
3 - Price Level
4 - Price Level D
5 - Price Level E
6 - Price Level F

Payment Method N/A

20 characters, alphanumeric.20 characters, alphanumeric.

Payment Notes N/A

255 characters, alphanumeric. 

Available only if a Payment Method is entered.

255 characters, alphanumeric. 

Available only if a Payment Method is entered.

Name on Card N/A

50 characters, alphanumeric. 

Available only if a credit card or debit card payment method type is entered.

50 characters, alphanumeric. 

Available only if a credit card or debit card payment method type is entered.

Last 4 Digits on Card N/A

Due to PCI Compliance regulations, only the last 4 digits are stored.Due to PCI Compliance regulations, only the last 4 digits are stored.

Expiration Date N/A

5 characters in mm/yy format. 

Available only if a credit card or debit card payment method type is entered.

5 characters in mm/yy format. 

Available only if a credit card or debit card payment method type is entered.

Address (AVS) N/A

28 characters, alphanumeric.

Available only if a credit card or debit card payment method type is entered.

28 characters, alphanumeric.

Available only if a credit card or debit card payment method type is entered.

ZIP (AVS) N/A

10 characters, alphanumeric. 

Available only if a credit card or debit card payment method type is entered.

10 characters, alphanumeric. 

Available only if a credit card or debit card payment method type is entered.

Account N/A
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5 characters, numeric. May have an optional nonnumeric separator between the first digit and the last 4 digits, 
for example, 11234.
5 characters, numeric. May have an optional nonnumeric separator between the first digit and the last 4 digits, 
for example, 11234.

Salesperson Rep

31 characters, alphanumeric 31 characters, alphanumeric 

Salesperson Card ID N/A

15 characters, alphanumeric15 characters, alphanumeric

Comment N/A

255 characters, alphanumeric.255 characters, alphanumeric.

Shipping Method N/A

20 characters, alphanumeric.

Printed Form N/A

255 characters, alphanumeric255 characters, alphanumeric

Freight Tax Code N/A

3 characters, alphanumeric. When importing, must match a preexisting tax code in the Tax Code List.3 characters, alphanumeric. When importing, must match a preexisting tax code in the Tax Code List.

Receipt Memo N/A

255 characters, alphanumeric.255 characters, alphanumeric.

Invoice/Purchase Order Delivery N/A

P = To be Printed 
E = To be Emailed 
B = To be Printed & Emailed 
A = Already Printed or Sent

If field is left blank, the field will be set to P = To be Printed.

P = To be Printed 
E = To be Emailed 
B = To be Printed & Emailed 
A = Already Printed or Sent

If field is left blank, the field will be set to P = To be Printed.

^ Record ID N/A

10 numeric characters.

The Record ID is an internal number within the AccountEdge company file.

10 numeric characters.

The Record ID is an internal number within the AccountEdge company file.
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Field Comparison: AccountEdge = QuickBooksField Comparison: AccountEdge = QuickBooks

ItemsItems
* Required Field.  Must have a valid matching import field.  * Required Field.  Must have a valid matching import field.  

* Item Number N/A

Max 30 characters, alphanumeric.Max 30 characters, alphanumeric.

Item Name Item

30 characters, alphanumeric.30 characters, alphanumeric.

Buy N/A

1 character. Any non-blank character signifies that the item is bought.1 character. Any non-blank character signifies that the item is bought.

Sell N/A

1 character. Any non-blank character signifies that the item is sold.1 character. Any non-blank character signifies that the item is sold.

Inventory N/A

1 character. Any non-blank character signifies that the item is inventoried.1 character. Any non-blank character signifies that the item is inventoried.

Asset Acct Asset Account

Linked asset account. Must be a valid, preexisting AccountEdge account number. 5 characters, numeric. May 
have an optional non-numeric separator between the first digit and the last 4 digits (example: 1-1234).
Linked asset account. Must be a valid, preexisting AccountEdge account number. 5 characters, numeric. May 
have an optional non-numeric separator between the first digit and the last 4 digits (example: 1-1234).

Income Acct Account

Linked income account. Must be a valid, preexisting AccountEdge account number. 5 characters, numeric. 
May have an optional non-numeric separator between the first digit and the last 4 digits (example: 1-1234).
Linked income account. Must be a valid, preexisting AccountEdge account number. 5 characters, numeric. 
May have an optional non-numeric separator between the first digit and the last 4 digits (example: 1-1234).

Expense/COS Acct COGS Account

Linked expense or cost of sales account. Must be valid, preexisting AccountEdge account number. 5 
characters, numeric. May have an optional non-numeric separator between the first digit and the last 4 digits 
(example: 1-1234).

Linked expense or cost of sales account. Must be valid, preexisting AccountEdge account number. 5 
characters, numeric. May have an optional non-numeric separator between the first digit and the last 4 digits 
(example: 1-1234).

Item Picture N/A

File name of the graphic. 255 characters, alphanumeric.File name of the graphic. 255 characters, alphanumeric.

Description Description

Max 255 characters, alphanumeric.Max 255 characters, alphanumeric.

Use Desc. On Invoice N/A

1 character. Any non-blank character signifies that the item description and not the item name should be used 
on the invoice.
1 character. Any non-blank character signifies that the item description and not the item name should be used 
on the invoice.
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Custom List 1 = N/A 
Custom List 2 = N/A 
Custom List 3 = N/A

30 characters, alphanumeric (each field). When importing, each entry must match an existing list entry.

Custom List 1 = N/A 
Custom List 2 = N/A 
Custom List 3 = N/A

30 characters, alphanumeric (each field). When importing, each entry must match an existing list entry.

Custom Field 1 = N/A 
Custom Field 2 = N/A 
Custom Field 3 = N/A

30 characters, alphanumeric (each field).

Custom Field 1 = N/A 
Custom Field 2 = N/A 
Custom Field 3 = N/A

30 characters, alphanumeric (each field).

Primary Vendor Preferred Vendor

31 characters, alphanumeric. When importing, must match the name of a vendor card in the card file. If the 
vendor is an individual, AccountEdge matches the name in this format: Last name, First name.
31 characters, alphanumeric. When importing, must match the name of a vendor card in the card file. If the 
vendor is an individual, AccountEdge matches the name in this format: Last name, First name.

Vendor Item Number N/A

30 characters, alphanumeric.30 characters, alphanumeric.

Tax When Bought N/A

1 character. Any non-blank character signifies that the item is taxable when bought.1 character. Any non-blank character signifies that the item is taxable when bought.

Buy Unit Measure N/A

5 characters, alphanumeric.5 characters, alphanumeric.

# Items/Buy Unit N/A

4 characters, numeric.4 characters, numeric.

Reorder Quantity N/A

10 characters, numeric, including 3 decimal places.10 characters, numeric, including 3 decimal places.

Minimum Level N/A

10 characters, numeric, including 3 decimal places.10 characters, numeric, including 3 decimal places.

Selling Price Price

11 characters, numeric, including 4 decimal places.11 characters, numeric, including 4 decimal places.

Sell Unit Measure N/A

5 characters, alphanumeric.5 characters, alphanumeric.

Tax When Sold Taxable

1 character. Any non-blank character signifies that the item is taxable when sold.1 character. Any non-blank character signifies that the item is taxable when sold.

#Items/Sell Unit
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4 characters, numeric.4 characters, numeric.

Quantity Break 1 N/A

This amount must be 0.000; set automatically by AccountEdge.This amount must be 0.000; set automatically by AccountEdge.

Quantity Break 2 N/A

10 characters, numeric including 3 decimal places. Must be greater than Quantity Break 2 but less than 
Quantity Break 4.
10 characters, numeric including 3 decimal places. Must be greater than Quantity Break 2 but less than 
Quantity Break 4.

Quantity Break 3 N/A

10 characters, numeric including 3 decimal places. Must be greater than Quantity Break 2 but less than 
Quantity Break 4.
10 characters, numeric including 3 decimal places. Must be greater than Quantity Break 2 but less than 
Quantity Break 4.

Quantity Break 4 N/A

10 characters, numeric including 3 decimal places. Must be greater than Quantity Break 3 but less than 
Quantity Break 5.
10 characters, numeric including 3 decimal places. Must be greater than Quantity Break 3 but less than 
Quantity Break 5.

Quantity Break 5 N/A

10 characters, numeric including 3 decimal places. Must be greater than Quantity Break 4.10 characters, numeric including 3 decimal places. Must be greater than Quantity Break 4.

Price Level A-F,
Qty Break 1
Price Level A-F,
Qty Break 1

11 characters, numeric including 4 decimal places. 11 characters, numeric including 4 decimal places. 

Price Level A-F,
Qty Break 2-5

N/A

11 characters, numeric including 4 decimal places. (Price levels are available only when valid quantity breaks 
have been designated for the item.)
11 characters, numeric including 4 decimal places. (Price levels are available only when valid quantity breaks 
have been designated for the item.)

Inactive Item N/A

If blank or the letter N appears in the field, the item won’t be marked and it will have active status.
If the field contains a Y or any non-blank character (other than N), the item will be marked and it will have 
inactive status.

If blank or the letter N appears in the field, the item won’t be marked and it will have active status.
If the field contains a Y or any non-blank character (other than N), the item will be marked and it will have 
inactive status.

Standard Cost N/A

10 characters, numeric including 4 decimal places.10 characters, numeric including 4 decimal places.

Default Ship/Sell Location N/A

10 characters, alphanumeric. When importing, must match a pre-existing location in the company file. 10 characters, alphanumeric. When importing, must match a pre-existing location in the company file. 

Default Recvd/Auto Location N/A

10 characters, alphanumeric. When importing, must match a pre-existing location in the company file. 10 characters, alphanumeric. When importing, must match a pre-existing location in the company file. 
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Importing QuickBooks accounts data into AccountEdge

Before you begin

Before beginning this step of the conversion process, use the AccountEdge Company File 
Assistant to create your company file. For more information on how to create a company file 
within AccountEdge, see AccountEdge help files Company File Overview (Setting up your 
company file > Overview) and Create a company file (Setting up your company file > Create a 
company file).

We recommend that you make a copy of your AccountEdge company file prior to each step.  
Keep an extra copy of the original file used before you begin.  

Note: when selecting your accounts, select ‘I would like to import my accounts list’ in Step 4 
of the AccountEdge New Company File Assistant.

1. Open your QuickBooks file, click on the reports drop down menu and select Lists > 
Account Listing. 
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2. Select the Customize button to access the available fields.

3. Select the fields you would like to export to AccountEdge and select OK. AccountEdge 
suggests you import the following fields: Account name and Account number. Select OK. 

Note: Account balances should be entered from a Profit and Loss and Balance Sheet Report. 
See instructions for Entering Opening Balances and Historical Transactions.  Speak to your 
accountant to get a set of financial statements that you can use to enter Opening Balances.  

   

4. Select Export to Excel. Excel will launch the report. 

5. Select and delete the report headers so that the header records occupy the first row of the 
spreadsheet.

6. Refer to the Importing Fields section, above, to confirm that all fields are in the 
appropriate format.
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7. Highlight the ‘Account #’ column and insert a new column adjacent to it. Enter 
AccountEdge Account #’ in the header to label this column. To add a column, go to the 
Insert menu and select ‘column.’

8. In the first cell of your new column, create a formula that multiplies the QuickBooks 
account number by 10 (see illustration below). This will format the QuickBooks 4-digit 
Account numbers into an AccountEdge 5-digit Account number.  

Note: This will depend on your version of QuickBooks, if your accounts already have 5 digits, 
you can skip this step. If your accounts have less digits or no account number, we 
recommend that you add zero’s at the end or assign numbers when you get the file into 
Excel.  All accounts must have an account number.  Check with your accountant  or 
bookkeeper who may be able to provide a better account list than QuickBooks.  

The key is that your Accounts List and your accountants Chart of Accounts are as similar as 
possible.   

9. Copy and paste this formula down the column.

                     

10. In AccountEdge, Other Expense accounts start with the number 9. If you have Other 
Expense accounts that start with 7 in QuickBooks, you will need to change the first 
number of the account # to the number 9.
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Note: Account names in AccountEdge can not be longer than 30 characters. Make sure ALL 
your accounts have a 5 digit number assigned to them in the Excel file.  

All accounts in AccountEdge must have an Account #, must be 5 digits long, and must follow 
the numbering format below). Therefore, if you have accounts with zero as the account 
number, you must create a new account number using the AccountEdge format listed 
below:

Account Number Account Type
1XXXX Asset

2XXXX Liability
3XXXX Equity

4XXXX Income

5XXXX Cost Of Goods

6XXXX Expense

8XXXX Other Income

9XXXX Other Expense

11. Confirm that all of the fields you would like to import into AccountEdge are in the correct 
format and meet the criteria found in the Importing Fields section, above.

12. Save the file in a tab-delimited, text format.

13. Open the AccountEdge company file, click on the File drop-down menu, and select Import 
Accounts > Accounts Information.
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14. Select Tab-Delimited as the Import file format. Select First record is Header Record, and 
select Duplicate records Reject Them. Select Continue.

15. The Open File window appears. Select the tab-delimited file you saved in step 12.

16. Here you will actually match your old QuickBooks fields to your new AccountEdge fields. 
Select the field on the left and then select the field you would like to match it to on the 
right. Continue this process until all desired fields have been matched appropriately. 

Select ‘Import’.

17.  A pop-up window will appear telling how many records were imported. If it says all the 
records were imported, you have completed importing your QuickBooks accounts into 
AccountEdge company file. If the window shows some records were skipped, or that some 
records were imported with warnings, continue to the next step.

18. If the warning window shows some records were skipped, or that some records were 
imported with warnings, open the AccountEdge Import Log (found in the same folder that 
contains your AccountEdge company file). The AccountEdge Import Log is a log that lists 
any problems that occurred during the import process, and gives information about 
rejected duplicate records.

The errors and warnings that occurred during the import process are listed at the bottom 
of the log. This will correspond to the number in front of each record. If an Import Log 
already exists when you import, the existing report will be replaced. Open the Excel 
spreadsheet you created in step 9, make the corrections needed based on the error 
messages, and reimport the file. Be sure to select Duplicate Records Update Existing 
Record.

Open the Excel spreadsheet you imported, make the corrections needed based on the 
error messages and reimport the file. Be sure to select Duplicate Records Update Existing 
Record.

19. For Information about Entering Account Opening Balances please read the Entering 

copyright © 2010 Acclivity, LLC.

http://help.acclivitysoftware.com/us/ae10/mac/companyfile.4.5.htm
http://help.acclivitysoftware.com/us/ae10/mac/companyfile.4.5.htm


opening account balances (Setting up your company file > Enter account opening 
balances) help document.

Importing QuickBooks Customer (and Vendor) Data in to 
AccountEdge

Note: The instructions found in this section focus on customers.  It can be used to import  

‘Vendor’, ‘Employee’ and ‘Other’ contacts as well.  

We recommend that you make a copy of your AccountEdge company file prior to each step.  
Keep an extra copy of the original file used before you begin.  

For more information on customizing your card file, please read the Customizing cards 
(Customizing your card file > Contact management > Customizing cards) help document.

1. Open your QuickBooks file, select the reports drop down menu, select Lists, and then 
Customer Contact List.

2. Select the customize button to access the available fields.
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3. Select the fields you would like to export to AccountEdge. We suggests you import the 
following fields: Company or First Name, Last Name, Street 1, Street 2, City, State, and Zip, 
Contact, Phone, and Email. Select OK.

4. Select Export to Excel. Excel will launch the report. Select and delete the report headers so 
that the header records occupy the first row of the spreadsheet.

Note: If your QuickBooks Customer Names contains commas, they will be imported into 
AccountEdge with quotation marks, unless they are removed before saving this file. Confirm 
that the fields you are importing into AccountEdge meet the format and criteria in the 
Importing Fields section, above.

5. Save the Excel spreadsheet as a tab-delimited file. 

6. Open your new company file in AccountEdge. 

7. Select the File drop down menu and select Import Data > Cards > Customer Cards.
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8. Select the following: Tab-Delimited as the Import File Format, First record is Header 
Record, Duplicate records Reject Them, and select how you would like to determine if they 
are duplicates by selecting Co/Last Name or Card ID.

9. In the open file window, select the tab-delimited file you saved in step 5.

10. Select the field on the left and then select the field you would like to match it to on the 
right. Continue this process until all desired fields have been matched appropriately. 

Select ‘Import’.

Note: Make sure you have a duplicate copy of your AccountEdge company file prior to 
importing.    
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11. A pop-up window will appear telling how many records were imported. If it says all the 
records were imported, you have completed importing your QuickBooks accounts into 
your AccountEdge company file. If the window shows some records were skipped, or that 
some records were imported with warnings, continue to the next step.

12. If the warning window shows some records were skipped, or that some records were 
imported with warnings, open the AccountEdge Import Log (found in the same folder that 
contains your AccountEdge company file).

The AccountEdge Import Log is a log that lists any problems that occurred during the 
import process, and gives information about rejected duplicate records.

The errors and warnings that occurred during the import process are listed at the bottom 
of the log. This will correspond to the number in front of each record. If an Import Log 
already exists when you import, the existing report will be replaced.

Open the Excel spreadsheet you created in step 5, make the corrections needed based on 
the error messages, and reimport the file. Be sure to select Duplicate Records Update 
Existing Record.
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Importing QuickBooks Item Data in to AccountEdge

Before you begin

We recommend that you make a copy of your AccountEdge company file prior to each step.  
Keep an extra copy of the original file used before you begin.  

Before proceeding, it is important to fully understand how AccountEdge handles Inventory. 
You can do so by reading AccountEdge’s Creating items (Inventory > Creating items) help 
document.

1. Open your QuickBooks company file. Select the reports drop-down menu and then select 
List > Item Listing.

2. Select the customize button to access the available fields.

3. Select the following fields from the list to import into AccountEdge: Item, Description, 
Account, Price, Asset Account, and COGS/Account from the list, then select OK.
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4. Select Export to Excel - Excel will launch and the report will open.

5. Select and delete the report headers so that the header records occupy the first row of the 
spreadsheet.

6. For each item, AccountEdge will need to know if you buy the item, sell the item and/or 
inventory the item and what accounts you will use to track for each item. For more 
information about setting up your inventory in AccountEdge, please refer to 
AccountEdge’s Creating items (Inventory > Creating items) help document and click To 
create an item.

You will need to import the Asset Account # (known as Asset Account in QuickBooks) you 
use to track inventoried items, the Income Account # (Account in QuickBooks) you use to 
track the sale of the item, and the Expense/Cost Of Sales Account# (COGS Account in 
QuickBooks) you use to track when you purchase the item.

Use the find and replace feature in Excel to convert the account names into the 
corresponding Account # you imported from QuickBooks during the Accounts Import 
procedure.

7. Insert a column to the right of each of the following columns and create the 
corresponding headers:

• To the right of the Asset Account column - create a new column and title it Inventory.

• To the right of the COGS Account column - create a new column and title it Buy.

• To the right of the Account column - create a new column and title it Sell.

In the Inventory column, designate with an “X” the items you would like AccountEdge to 
track as inventoried items. In the Sell column, designate with an “X” the items you would 
like AccountEdge to track as items you sell. In the Buy column, designate with an “X” the 
items you would like AccountEdge to track as items you buy.

8. Confirm that all of the fields you are about to import into AccountEdge are in the correct 
format, and meet the criteria found in the Importing Fields section, above.

For more information on managing import and export records, please see AccountEdge’s 
File formats for importing and exporting (Importing and exporting data > Managing 
import and export records > File formats for importing and exporting) help document.

9. Save the Excel spreadsheet you have completed as a tab-delimited file. 

10. Open your new AccountEdge company file. 

11. Select the File drop down menu and select Import Data > Items.
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12. Select the following: Tab-delimited as the Import File Format, First Record is Header 
Record, Duplicate Records Reject Them.

13. In the open file, select the tab-delimited file you saved in step 9.

14. Match your old QuickBooks fields to your new AccountEdge fields. Select the field on the 
left and then select the field you would like to match it to on the right. Continue this 

process until all desired fields have been matched appropriately. Select ‘Import’.

15. A pop-up window will appear telling how many records were imported. If it says all the 
records were imported, you have completed importing your QuickBooks Items into your 
AccountEdge company file. If the window shows some records were skipped, or that some 
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records were imported with warnings, continue to the next step.

16. If the warning window shows some records were skipped, or that some records were 
imported with warnings, open the AccountEdge Import Log (found in the same folder that 
contains your AccountEdge company file). The AccountEdge Import Log is a log that lists 
any problems that occurred during the import process, and gives information about 
rejected duplicate records.

The errors and warnings that occurred during the import process are listed at the bottom 
of the log. This will correspond to the number in front of each record. If an Import Log 
already exists when you import, the existing report will be replaced.

Open the Excel spreadsheet you created in step 9, make the corrections needed based on 
the error messages, and reimport the file. Be sure to select Duplicate Records Update 
Existing Record.

17. For information on how to enter your inventory opening balances please refer to 
AccountEdge’s Enter your inventory opening balances (Advanced setup > Enter your 
inventory opening balances) help document.

Still have questions?

• Visit our site for more help and conversion assistance.  

• Consider working with one of our AccountEdge Certified Consultants – they are experts in 
setting up and using AccountEdge and many also have QuickBooks experience.  
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